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 ____________________________________________________________________________ 

Overview ____________________________________________________________________________ 
 
 

FEHT is an acronym for Finite Element Heat Transfer.  FEHT was originally designed to 
facilitate the numerical solution of steady-state and transient two-dimensional conduction heat 
transfer problems.  However, the fundamental equations describing conduction heat transfer, 
bio-heat transfer, potential flow, steady electric currents, electrostatics, and scalar 
magnetostatics are similar.  The current version (Version 8) of FEHT has been designed to 
solve problems in all of these disciplines.  It is designed for use on Windows operating systems 
XP, 7, 8, and 10.   
 
Most practical conduction heat transfer problems can not be solved analytically.  As a result, 
numerical solutions provide the only feasible way in which these problems can be solved.  
There are two common approaches: finite-difference and finite-element methods.  In both 
approaches, the governing partial differential conduction equation subject to specified boundary 
(and for transient problems, initial) conditions is transformed into a system of ordinary 
differential equations (for transient problems) or algebraic equations (for steady-state problems) 
that are solved to yield an approximate solution for the temperature distribution.  In the finite 
difference method, spatial discretization of the problem using a set of nodal points followed by 
application of energy balances and rate equations for each of the discrete segments directly 
results in a system of equations which are solved to obtain the temperature at each nodal point.   
 
In the finite-element method, the partial differential equation is transformed into an integral 
form.  Numerical approximation of the integral results in the system of algebraic or ordinary 
differential equations.  In both the finite-difference and finite-element methods, the accuracy of 
the solution is improved as the number of nodes used to discretize the region is increased.  The 
finite-element method has been chosen over the finite-difference method primarily because its 
use of triangular elements greatly simplifies the discrete approximation of non-rectangular 
geometries. 
 
FEHT provides three essential functions: Problem Definition, Calculations, and Output.  The 
Problem Definition commands provide a drawing environment in which the user draws the 
outlines of the materials with a series of straight lines that enclose an area.  After it is defined, 
the properties of the material represented by the outline and the boundary and initial (for 
transient problems) conditions can be defined.  These specifications are made by tagging the 
line, node, or material with a mouse click (causing it to flash) and then selecting the desired 
specification from a pull-down menu.  The Auto Mesh command can then be applied to create a 
rough triangular mesh.  The Reduce Mesh command can be used to reduce the mesh size.     
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Calculations are initiated from a pull-down menu.  The program first checks to see that all 
materials are properly discretized and the properties, boundary, and initial conditions are 
specified.  Any error detected during the checking is marked and described in a separate 
window at the top of the screen.  For transient problems, the computational method (Euler or 
Crank-Nicolson) and start, stop and time step are selected from a dialog box;  if no errors are 
detected, the calculations are initiated. 
 
A variety of output capabilities are provided.  For steady-state problems, the potentials 
(temperature,. voltages, magnetic potential, streamlines, or pressures) within the material may 
be shown at the nodal positions or in one of several types of contour plots.  The potential at the 
cursor position is displayed when the mouse button is depressed.  The potential gradients 
(temperature gradient, current density, electrical or magnetic flux density) within the materials 
can be displayed by arrows pointing in the direction of the gradient with the shaft length 
proportional to the gradient magnitude.  The flow of heat, charge, current, or magnetic flux 
across any element line may be determined by clicking the mouse button while the cursor is on 
the line.  For transient heat transfer problems, the temperatures of selected nodes may be 
displayed in a temperature versus time plot.  Heat flow can be plotted as a function of time.  
The contours and/or temperature gradients for each time step may be shown in sequence 
providing a 'movie' depicting the changes with time. 
 
The motivation behind the development of FEHT was for instruction.  Although undergraduate 
engineers are exposed to numerical solution methods, they are typically not in a position to 
solve the more interesting practical problems after completing the course due to a lack of 
experience.  The problems encountered by students in an undergraduate course are typically 
one-dimensional or two-dimensional with very simple geometry that are used to illustrate the 
basic concepts.  As a result, students do not have the opportunity to learn how to choose 
appropriate nodal networks as needed for complex geometries and/or boundary conditions, to 
apply variable nodal spacing, or to ensure smooth transitions at the interface between different 
materials. These subjects do not receive more attention because such analyses currently involve 
a prohibitive amount of programming effort and student time. 
 
FEHT offers the advantages of a simple set of intuitive commands with which a novice can 
quickly learn to use for solving complex two-dimensional problems.  FEHT is ideally suited for 
instruction in electrical engineering fields and mechanical engineering heat transfer and bio-
engineering courses and for the practicing engineer faced with the need for solving practical 
problems. 
 
The remainder of this manual is organized into three chapters and two appendices.  Chapter 1, 
intended for the new user,  illustrates the solution of a simple heat transfer problem from start to 
finish.  Chapter 2 provides specific information on the various functions and controls for each 
of the FEHT windows and menu commands.  Much of this reference information is available 
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from within the program by pressing the F1 key which brings up the online Help program.  
Chapter 3 provides a brief summary of the finite-element method with references to more 
complete descriptions.   
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C  H  A  P  T  E  R  1 

Getting Started 
 
This chapter, intended for the new user, will guide the solution of a simple heat transfer 
problem from start to finish.  After trying the problem outlined in this chapter, you may wish to 
review the reference information in Chapter 2. 
 
Installing FEHT on your Computer 
 
FEHT is a 32-bit application that will run under all modern Microsoft Windows 32 and 64-bit 
operating systems including Windows XP, 7, 8, and 10.  An installation program named 
SETUP_FEHT.exe is provided that must be run from the Windows operating system.  Double-
click on the program file to start the installation process. 
 

  
The installation program will provide a series of prompts which will lead you through the 
complete installation of the FEHT program and its associated files.     
 
 
Starting FEHT  
  
The installation program will create a menu item in the Programs section of the Start menu.  
The FEHT program is represented by the icon shown below.  Both the program and FEHT 
Files having a .FET filename extension will be shown with this icon.  Double-clicking on this 
icon will start the program.   
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Background Information 
 
FEHT begins by displaying a dialog window showing the version number of the program and 
the owner registration number.  This information will be needed if you request technical 
support.  Click the OK button to dismiss the dialog window. 
 
Detailed help is available at any point in FEHT.  Pressing the F1 key will bring up a Help 
window relating to the foremost window.  Clicking the Contents button will present the Help 
index shown below.  Clicking on an underlined word will provide help relating to that subject.   
 

  
There are several example problems with completed problem definitions stored in the 
Examples subdirectory on the disk that can be accessed using the Open command in the File 
menu.  These example problems illustrate the necessary triangular discretization and allow a 
review of the output commands after the Calculate command in the Run menu has been 
issued. 
 
Commands are distributed among nine pull-down menus.  A brief summary of their functions 
follows.  Detailed descriptions of the commands appear in the next chapter.   
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The File menu provides commands for loading and saving work files, printing, and copying 
information to and from the clipboard. 
 
The Subject menu allows the problem discipline to be selected from the areas of heat transfer, 
electrical currents, electrostatics, scalar magnetostatics, bio-heat transfer, potential flow and 
porous media flow .   
 
The Setup menu commands allow specification of the unit system, size, scale, coordinate 
system (Cartesian or cylindrical),  and problem type (steady-state or transient). 

The Draw menu contains the commands to outline a material, manually or automatically create 
a mesh, reduce the mesh, delete or group selected items, reposition nodes, and add text. 

The Display menu contains a variety of commands that affect the screen display including a 
Zoom command to enlarge a selected part of the screen. 

The Specify menu allows material properties, internal generation, boundary conditions and 
initial conditions to be specified. 

The Run menu contains commands to check a problem definition and to initiate or continue 
the calculations. 

The View menu provides the means to making one of the nine FEHT windows active.  The 
function of each window are described in Chapter 2. 

The Examples menu provides convenient access to a number of example problems.  Examples 
can also be opened with the Open command in the File menu. 

The Help menu provides access to the on-line help as well as to the F-Chart Software web site. 

To select a command, place the cursor on the desired menu title, press the mouse button, and 
while holding the button down, slide the cursor to the command you wish to execute; then 
release the mouse button.  Menus (or commands within a menu) which are not presently 
accessible are dimmed, as, for example, Specify in the menu bar shown above.  Dimmed items 
can not be selected.   
 
Online Help for any command in the pull-down menus can be obtained by first pressing and 
holding the mouse button down with the cursor positioned on the menu item and then pressing 
the F1 key. 
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A Practice Work Session 

 
The example problem is a steady-state heat transfer analysis of a furnace wall shown in the 
figure below.  The air within the furnace is maintained at 560°C.  The outside surface of the 
furnace is exposed to air at 30°C.  The furnace wall is made of brick.  The problem is to 
determine the temperature distribution in the brick wall and the total rate of heat transfer 
through the wall.   

5 m

3 m

4 
mAir at 560°C 2 
m

Brick
  

By default, FEHT is configured for steady-state heat transfer problems in Cartesian 
coordinates.  These characteristics apply to this practice problem and do not need to be 
changed.   
 
It is usually best to set the unit system, scale, and grid spacing at the start of a problem 
although they can be changed at any time.  Pull down the Setup menu and select the Scale and 
Size command which will bring up a dialog window in which the scale attributes can be 
entered. 
 
The small circles in the Scale and Size dialog window shown below are called radio buttons.  
Radio buttons control the unit system for heat transfer problems.  To change the unit system, 
move the mouse to position the cursor on the appropriate button and click the mouse button.  A 
reasonable scale for this problem is to have 1 cm on the screen represent 0.1 m.  Any item 
within a box can be changed.  The unit for length is, by default, centimeters but it can be set to 
mm, cm, m, or km by clicking in the units box to the right of the scale value.  (In the English 
system, the length unit can be inches, feet, yards, or miles.)  Click in the scale units box until it 
displays m for meters.   Then enter 0.1 in the scale edit box.  Note that double-clicking within 
any edit box causes the characters to be highlighted (shown in inverse).  Typing any character 
will replace the highlighted field with the entered character.  X0 and Y0 designate the location 
of the origin of the coordinate system on the screen in screen coordinates.  The default values, 
X0=0.0, Y0=0.0 correspond to the origin being placed at the lower left of the screen.  Gridlines 
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make the drawing easier to prepare.  Grid spacing is specified in the same coordinates as for 
the drawing.  Set the grid spacing and origin to suit the size of your monitor and the 
dimensions of your problem.  Click the OK button or press the Enter key to set these scale 
attributes.  

  
The first step is to sketch material outlines.  It is easier to prepare a scale drawing with a 
coordinate grid.  Select Show Grid from the Display menu.  Select Outline (free form) from 
the Draw menu.  Since this problem is symmetrical, we only need to analyze one quarter of the 
furnace.  Note that the X and Y coordinates of the cursor position for the selected unit system 
and scale are shown in the small window at the upper left, just below the menu bar.  Move the 
mouse to locate the cursor at position X=0.50 m, Y=2.50 m1.  Click the mouse to fix a node at 
the corner.  The first node is shown as a small closed circle.  Now, position the cursor at 
X=3.00 m, Y=2.50 m and click the mouse.  Hold the shift key down to provide a drawing aid 
for horizontal, vertical, or 45 lines.  Click on the remaining corners at X=3.00 m, Y=0.50 m; 
X=2.00 m, Y=0.50 m; X=2.00 m, Y=1.50 m; and X=0.50 m, Y=1.50 m.  Now click on the first 
corner.  The outline must begin and end on the same node without crossing any existing lines.  
At this point, the outline will flash, indicating that the outlining process is completed and the 
material within the flashing boundary is selected.   
 
At this point, you may wish to exactly locate the node positions since it unlikely that you were 
able to do so while drawing with the mouse.  Click on the node at the upper left of the drawing 
and then select the Boundary Conditions command in the Specify menu.  (Note that, as a 
short cut, you can accomplish the same result by double-clicking the mouse on the node.)  The 
Specify Node Temperature dialog window will appear with edit boxes for the node 
temperature and for the X and Y coordinates of the node.  In this case, we wish to alter the 

                                            
1 Note: It is not necessary to position the mouse cursor at the exact desired position. Just place the cursor close to 

the desired position.  The exact position can be later entered with the Boundary Conditions command in the 

Specify menu.   
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coordinates, not the node temperature.  Enter the coordinates X=0.50 and Y=2.50 as shown 
below.  FEHT will not let the node move to a position which causes existing lines to cross, so 
there is some restriction on the coordinates that you enter.  Note the FEHT displays the 
coordinates in exponential notation.  The E means ‘times ten to the power of’.  Repeat this 
process for all of the other nodes so that they are exactly positioned at the proper locations.  
After entering the coordinates of all of the nodes, save the file as Example 1.fet using the Save 
command in the File menu. 
 

 
 

The screen should now look like this. 
 

  
Click the mouse button anywhere within the outline.  This will cause it to flash, indicating that 
it is selected.  The outline number and name are shown in the center information window 
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below the menu bar.  The area enclosed by the outline is shown in the right information 
window.  A material must be selected (flashing) in order to specify its properties.  A material 
can be selected by clicking the mouse anywhere within it outline;  it is automatically selected 
just after it has been drawn.  Select Material Properties from the Specify menu.  A property 
dialog box will appear with default property names listed on the left.  Choose the material to be 
brick by clicking on Building Brick in the list on the left.  You can choose the pattern which 
will be used to identify the material by holding the mouse button down while the cursor is in 
the pattern box.  A pop-up palette will appear with the possible patterns.  The color of the 
pattern can also be selected in the same manner by clicking in the Color box.  The thermal 
properties of brick are displayed.  These properties can be changed to other values.  They may 
also be entered as a function of temperature and position as described in Chapter 2.  Leave the 
brick properties at their default values.  The properties dialog box should now appear like this. 
 

  
Click the OK button and the screen will be redrawn with the pattern you have chosen 
identifying the material.  You may wish to hide the pattern so that you can better see the nodes 
in the outline.  You can do this by selecting Hide Patterns from the Display menu. 
 
Next we will set the boundary conditions.  The vertical line at X=0.50 m and the horizontal 
line at Y=0.50 m are lines of symmetry and therefore there is zero heat flow across these lines.  
Move the cursor to a point near the center of one of these lines and click the button.  The line 
should now be flashing.  Move the cursor to the center of the other line and click.  Both lines 
should now be flashing.  Once a boundary is selected (flashing), the Boundary Conditions 
menu item in the Specify menu becomes accessible.  Select this menu item to bring up the 
Boundary Conditions dialog window.  Enter 0 (for adiabatic conditions) in the Heat Flux box 
and click the OK button.  A check mark will automatically appear in before the word Heat Flux 
to confirm that you are setting a heat flux boundary condition.    
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The two boundary lines are now shown with bold lines to indicate that the boundary conditions 
have been specified.   
 
The inside and outside walls of the brick are convective boundaries.  Click the mouse at a point 
near the center of each outside line causing them to flash.  Again, select Boundary Conditions 

from the Specify menu  Enter a convection coefficient of 5 W/m2-K and a fluid temperature of 
30°C.  The dialog window will appear as shown.  Click OK. 
 

 

The convection boundary information for the inside furnace walls is entered in the same 
manner.  Select both boundaries and again issue the Boundary Conditions command.  Enter 
the convection coefficient of 10 W/m2-K and a fluid temperature of 560°C.  Click the OK 
button.  Save the file. 
 
To complete the problem definition, it is necessary to discretize the brick material into 
triangular elements.  This task can be done manually (using the Element Lines command in 
the Draw menu) or automatically using the Auto Mesh command in the Draw menu.  Select 
the Auto Mesh command.  EES will break the outline into triangular elements as shown. 
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The Auto Mesh command first breaks the outline into a crude mesh and then reduces the mesh 
once.  If you wish to see the crude mesh, select the Undo command.  Use the Reduce Mesh 
command to return to the display above.   
 
Although there it is usually unnecessary, you can adjust the mesh that has been created using 
the Reposition Nodes command in the Draw menu.  You can add additional elements 
manually to the existing mesh (or create the mesh from the start) by selecting the Element 
Lines command from the Draw menu.  Click on an existing node or line to form one end of 
the element line. Then click on a node or line that will become the other end of the element 
line.  The following rules apply to manual element line construction. 
 
i.   The first end of the line must be on an existing line or node.  A new node will form at this 

point if one is not already there. 
ii. Element lines can not cross existing lines. 
iii. Clicking in the area surrounding the drawing or pressing the Esc key cancels the Element 

Lines command in the Draw menu. 
iv. It is not necessary to construct a coarse mesh since the Reduce Mesh command in the 

Draw menu can refine a mesh once it has been constructed. 
 
 

 
The problem definition is complete.  Select the Calculate command from the Run menu to 
initiate the calculations.  FEHT will first check the problem definition to ensure that the 
distributed materials are properly discretized and all properties and boundary conditions are 
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specified.  Any errors detected will be listed in the information window at the upper right of 
the screen, just below the menu bar.  This example problem is assumed to be steady-state.  Had 
this been a transient problem (by selecting Transient from the Setup menu), a dialog box 
would have appeared in which the start, stop and step times would be entered.  If no errors are 
found, a dialog window will appear indicating that the calculations are in progress.  When the 
calculations have been completed, the dialog box will display the elapsed time and other 
information. 
 

 
 
Click the Continue button.  A number of the output display windows in the View menu will 
now be accessible.  The temperatures within the wall can be displayed at each node by 
selecting Temperatures from the View menu.  Press and hold the left mouse down and move 
it within the outline.  The temperature at the cursor location will be displayed in the status bar 
at the upper left of the screen, replacing the cursor coordinates. 
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Temperature can also be displayed as a contour plot by selecting Temperature Contours 
which will bring up the following dialog window. 
 

  
Three types of contour plots are available, a banded plot showing gradations of hot to cold in 5 
sections, a continuous color plot showing temperatures as colors, and a contour plot of lines of 
constant temperatures.  The minimum and maximum values in the contour plot can be entered 
manually or FEHT will automatically find the limits if you click in the User/Auto box at the 
upper left.  Click the OK button or press the enter key to show the contour plot.  The scale is 
shown in the status bar at the top of the screen. 
 

 
In either the temperature or contour plot output, the temperature at the cursor position will be 
displayed at the upper left of the screen below the menu bar when the mouse button is 
depressed. 
 
One objective of this problem was to determine the total heat flow through the brick wall.  
Select Heat Flows from the View menu.  (It is also possible to determine the heat flow using 
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the Nodal Balances command, as described in Chapter 2.)  The screen will be redrawn with 
the nodes hidden.  Click on any line segment of the inside wall.  Hold the Shift key down to 
add the selected boundaries the previous selection.  An arrow will appear indicating the 
direction of heat flow for the selected boundaries.  The magnitude of the heat flow is shown in 
the information window at the top of the screen below the menu bar.  Clicking on adjacent 
lines forming the inside boundary in a clockwise or counterclockwise manner will allow the 
heat flows to be summed.  Alternatively you can select multiple lines by pressing the mouse 
outside of the material and dragging it while holding the mouse down to create a selection 
rectangle.  All lines within the selection rectangle will be selected.  After selecting all of the 
lines, you may wish to group them using the Group command in the Draw menu.  Clicking on 
any one of the lines in a group selects all lines in that group.  For one quarter of the problem, 
the heat flow through the furnace wall is 976.2.8 W.  The total heat flow through all sides of 
the wall is then 3904.8 W.   
 

 
 

 
 
Select Input from the View menu to return to the drawing window.  At this point, you may 
wish to explore.  Try using smaller triangular elements.  FEHT will automatically reduce the 
mesh size for you if you select the Reduce Mesh command in the Draw menu.  Will the 
smaller mesh significantly change the heat transfer rate?  How refined does the mesh need to 
be?  Compare the heat flows on the outside walls of the furnace with that on the inside.  Should 
they agree?  Do they? 
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C  H  A  P  T  E  R  2 
____________________________________________________________________________ 

Reference Information 
______________________________________________________________________________ 

 
 

FEHT Windows  

 
The FEHT program interacts with the user through three small information windows located 
just below the menu bar.  The specific functions and capabilities of each window are described 
later in the View Menu section of this chapter.  
 

 
 

 
 
Examples of the information display in the information windows are shown above.  The 
leftmost window ordinarily shows the coordinates at the cursor position in the scale selected 
with the Scale and Size command in the Options menu.  However, when the Potentials, 
Contours, or Gradients window is foremost, this window will display the potential (e.g., 
temperature) or gradient at the cursor position while the mouse button is depressed. 
 
The center window has two functions. When Input is selected from the View menu), it 
identifies the selected object, such as a selected line, node, or frame.  When any of the output 
display options are selected from the View menu, this box will display steady-state or, for 
transient problems, the time for which the Potentials, Contours, or Gradients, Heat Flows, or 
Nodal Balances output is displayed.  Clicking the mouse within this window will cause the 
time to increment to the next timestep and the output window to be refreshed. 
 
The larger information window on the right displays information appropriate to the current 
selection or situation.  For example, if a line is selected, as shown above, the boundary 
conditions for this line are displayed.  Error messages appear in this window as do the legends 
for contour and gradient plots.   
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Selecting Objects 

Problem definitions consist of material outlines, element lines and nodes.  These components 
must be “selected” in order to specify boundary conditions, properties, etc.  A node is selected 
by placing the cursor on the node and clicking the mouse button.  A line is selected by clicking 
the mouse button near the center of the line.  To select a material, click the mouse button on a 
point within the material outline, but not near an existing node or line.  Selected components 
will be indicated by flashing.   
 
FEHT first checks to see if the mouse click is on a node, then on a line, and then on a frame.  
You can hide the nodes and/or lines using the Show/Hide Nodes and Show/Hide Lines 
commands in the Display menu to make the selection process easier.  Alternatively, use the 
Zoom command in the Display menu to simplify selection of closely spaced components.   
 
Multiple selections of the same type can be made.  For example, clicking two nodes in 
sequence will select both nodes.  To unselect an item which has been selected and is currently 
flashing, click on it a second time.   
 
Lines that form the border of a material can also be selected with a selection rectangle in the 
Input and Heat Flows windows.  To select a series of connected border lines, press and hold the 
left mouse button down at a point outside of any material.  While holding the mouse button 
down, slide the mouse to a new location.  A dotted line rectangle will appear as shown below.  
All border lines within the rectangle will be selected when the mouse button is released.  

 
Nodes that form the border of a material can also be selected with a selection rectangle in the 
Nodal Balance window.  To add to an existing selection, hold the Shift key down while 
creating the selection rectangle. 
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Lines are ordinarily selected in order to specify boundary conditions.  As a short-cut, you can 
double-click the mouse on a line to immediately bring up the Boundary Conditions dialog box.  
Similarly, double-clicking within a material outline will immediately bring up the Material 
Properties dialog box. 
 
Selection of multiple nodes, lines, or groups is simplified by the Group command in the Draw 
menu.  When the objects are grouped, selecting any one of the objects within a group causes all 
of the object in the group to be selected.  For example, you may wish to group all boundaries 
which have the same boundary conditions.  To override the group selection, press and hold the 
Option key while selecting the object. 
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Entering Variable Properties and Boundary Specifications 

FEHT will accept numerical constants or equations for property information, boundary 
specifications and internal generation.  For example, the thermal conductivity of a material 
may be entered as a function of temperature and/or position.  Boundary specifications, such as 
the temperature or the convection coefficient along a line, may be a function of time as well.  
The numerical constants or equations are entered directly into the appropriate edit field of the 
dialog box.  The edit field will automatically scroll to accommodate long equations.    
 
The rules relating to the use of mathematical operators in equations conform closely to those 
used in FORTRAN, C, or Pascal.  For example, a property value, e.g., thermal conductivity can 
be entered as (3 + 0.04 * T ) / X.  FEHT will interpret this expression as the sum of 3 and the 
product of 0.04 and T all divided by X.  The thermal conductivity is evaluated at each nodal 
point.  The temperature and position at the point would be used to evaluate the property value.  
The * indicating multiplication is required.  Spaces are ignored.  Upper and lower case letters 
are treated identically.  The caret symbol (^) or ** can be used to indicate raising to a power.  
 
In the above equation, T is the temperature.  (V is used for voltage, M for magnetic potential, S 
for stream function value, and H for head).  Spatial position is represented by X and Y in 
Cartesian coordinates or by R and Z in cylindrical coordinates.  The units of the spatial 
coordinates must be the same as those used in the drawing, as shown in the upper right 
information window.  Boundary conditions may be a function of time, represented by the 
symbol Time.  Time will have units of seconds or hours, depending on the choice made in the 
Transient Calculation dialog box.  
 
FEHT equations may also make use of the following built-in functions. 
 
 abs(z) returns the absolute value of z 
 cos(z) returns the cosine of z, where z is in radians 
 exp(z) returns the exponential of z 
 ln(z) returns the natural logarithm of z 
 log(z) same as ln(z) 
 max(a,b) returns either a or b, whichever is larger 
 mod(a,b)   returns the remainder of a/b 
 min(a,b) returns either a or b, whichever is smaller 
 sin(z) returns the sine of z, where z is in radians 
 sqrt(z) returns the square root of z 
 sqwv(z) square-wave function with amplitude ranging between +/–1;      z is in radians, 

similar to the sin(z) function 
 trunc(z) returns the value of z with the decimal part set to zero 
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Working with Menus 

Commands are distributed among nine pull-down menus appearing at the top of the screen.  (A 
tenth menu can be created under user control to display a grouped set of problems.)  To select a 
command, place the cursor on the desired menu title, press the mouse button, and while 
holding the button down, slide the cursor to the command you wish to execute; then release the 
mouse button.  Many of the menu items have command key equivalents.  That is, they can be 
executed either by using the mouse or by pressing the keys indicated in the menu.  Help for any 
menu item can be made to appear by pressing the F1 key with the mouse positioned on the 
menu command.   
 
The remainder of this chapter provides detailed descriptions of each of the menu commands, 
starting with the File menu.  Menu names and command names appearing in the menus will be 
shown in bold face.  Much of the information presented here is available within the program by 
pressing the F1 key while holding the mouse button down on the menu item. 
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File Menu 

 
New initiates a new work session.  All variables will be reset and the screen will be cleared.  If 

an unsaved problem definition exists, you will be asked if you wish to save your work, as if 
the Save As command were issued.   

 
Open will allow you to access and continue working on any file saved previously with the 

Save or Save As commands.  After the confirmation for unsaved work, a dialog window 
will appear showing the names of all previously saved FEHT files in the current directory.  
FEHT files have a .fet filename name extension.  If you wish, you can view the files in 
another directory or on another drive.  The directory can be changed by clicking on the 
names within the Directories: list and the drive designation can be changed by clicking 
within the Drives list.  To select a file, click on the file name in the file name list or enter 
the file name in the File Name edit box at the upper left.  It is not necessary to supply the 
.fet filename.   

 
Save will save your problem definition with the same file name (shown after Save in the menu) 

and on the same disk it was last saved.  For a new work session, you will be prompted to 
supply a file name, just as if the Save As command were selected.  All input information 
concerning the problem definition including property data is saved on the disk.  The output 
is not saved but it can be restored by the Calculate command.  The Save menu item is 
dimmed after the save operation until a change is made in the problem definition.  The 
filename appears in the title bar of the Input window. 

  
Save As provides the same function as the Save command except that it will first prompt you 

to supply a file name.  This command allows you to save the problem definition with 
another name or on another disk drive than used previously.  A dialog window will appear 
in which you must supply a file name.  The filename will be shown as ‘untitled’.  Enter the 
file name of your choice in its place to save a copy of the file with this file name. 
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Print will print the contents of the window currently being displayed.  You may first want to 
set printer options such as the scaling factor or Landscape/Portrait mode with the Printer 
Setup command. 

 
Printer Setup allows the printer, the paper orientation, the scaling factor and other printer 

options to be specified.  These options will then be in effect when the Print command is 
issued and they will remain in effect until FEHT is terminated.  

 
Copy To Clipboard copies what you see on the screen to a temporary memory storage area 

called the Clipboard thereby allowing the output of this program to be exported to other 
applications, such as a word processor or a drawing program.  The contents of all windows 
except the Report window are copied into a bitmap format.  The Report window contents 
are copied as tab-delimited which can be pasted directly into a spreadsheet program or a 
word processor. 

 
Paste From Clipboard copies the contents of the Clipboard to the screen.  The purpose of this 

command is to allow a drawing prepared by another application to be imported into FEHT 
as a drawing template.  To use this feature, it is first necessary to prepare the drawing in a 
drawing program.  The drawing may be either in bitmap or MetaPict format.  The drawing 
must then be copied to the Clipboard (using the application's Copy command).  The 
imported drawing can not be used directly in the problem definition.  Rather, it provides a 
template that may be traced.  It is particularly convenient to use a template when the 
drawing involves circles or other non-linear shapes.  Once pasted onto the screen, the 
template can be moved and resized with the Size/Move Template command in the Draw 
menu.  Use the Hide Template command in the Display menu to remove the template 
from view. 

 
Quit provides a graceful way to exit the program.  If there have been any changes to your file, 

you will be given the opportunity to save the file as if  the Save As command were issued.   
 
The remaining items in the File menu are recently accessed filenames.  Selecting any of these 
filenames opens the file.  This capability may be disabled for network installations. 
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Subject Menu 

 
 

The Subject menu controls the type of problem which is to be solved.  The default 
configuration is for heat transfer problems.  The subject should be selected before any drawing 
is started since selecting a subject will initiate a new work session, just as if the New command 
were issued.  In addition, default property data for the selected subject will be read in and the 
menus and dialog boxes will be reconfigured to conform with the selected subject.  A check 
mark identifies the currently selected subject. 
 
Heat Transfer configures FEHT for steady-state or transient heat transfer problems.  The 

governing equation in Cartesian coordinates is 
 

  b b

T T T
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                  
  

 where  
 T  is temperature [C or K, F or R] 
 q  is the local internal generation rate per unit volume [W/m3 or Btu/hr-ft3] 

    is the local density [kg/m3 or lbm/ft3] 
 c  is the local specific heat [kJ/kg-K or Btu/lbm-R] 
 t  is time [sec or hours] 
 k is the thermal conductivity [W/m-K or Btu/hr-ft-R] 
 
Extended Surfaces configures FEHT for steady-state or transient, two-dimensional problems 

involving extended surfaces.  The term ‘extended surface’ refers to a thin solid of thickness 
 in the z-direction that experiences two-dimensional (x,y) conduction within its 
boundaries and convection from its surfaces to an adjoining fluid.  A common extended 
surface is the fin, which is used in applications to enhance heat transfer from a base surface 
to an adjoining fluid.  The governing equation in Cartesian coordinates is 

 

 2a
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 where  
  thickness of extended surfaces [m or ft]  
 T temperature [°C or K, °F or R]  
 aq  applied surface heat flux [W/m2 or Btu/ft2]  

 q  rate of internal generation rate per unit volume [W/m3 or Btu/hr-ft3]  

 h convection coefficient between surfaces and the adjoining fluid [W/m2-K or 
Btu/hr-ft2-R]  

 T temperature of adjoining fluid  [°C or K, °F or R]  
    density [kg/m3 or lb/ft3]  
 c  specific heat [kJ/kg-K or Btu/lb-R]  
 t  time [s or h]  
 
 Note that, with this option, x and y are the dimensions of the fin.  The fin thickness, , is 

the dimension into the screen.  The fin is assumed to be thin such that there are no gradients 
in the direction into the screen.  Convection is assumed to occur on both sides of the fin and 
that is the reason for the factor of 2 appearing before the convection coefficient.  If 
convection only occurs on one side of the fin, the convection coefficient should be reduced 
by a factor of 2.  The fin heat transfer coefficient, fluid temperature, and surface heat flux 
are specified with the Surface Properties menu item.  The fin thickness is specified in the 
Material Properties dialog. 

 
Electric Currents configures FEHT to solve two-dimensional, steady-state or transient 

problems in electrical conduction.  The governing equation in Cartesian coordinates is 
 

 
x


V

x
+

y


V

y
= C

V
t   

 where  
 V  is electric potential [V] 
  is the local conductivity [S/m] 
 C is the capacitance [F/m] 
 t  is time [sec or hours] 
 
Electrostatics configures FEHT to solve two-dimensional steady-state problems in 

electrostatics.  The governing equation in Cartesian coordinates is 
 


x


V

x
+


y


V

y
+  = 0

  
 where  
 V  is electric potential [V] 
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  is the electric permittivity [F/m] 
  is the volume charge density [C/m3] 
 
 
Magnetostatics configures FEHT to solve scalar two-dimensional steady-state problems in 

magnetostatics.  The governing equation in Cartesian coordinates is 
 



x

V

x
 + 



y

V

y
 = 0

  
 where  
 V  is magnetic scalar potential [V] 
  is the magnetic permeability [H/m] 
 
 
Bio-Heat Transfer configures FEHT to solve steady-state or transient, two-dimensional heat 

transfer problems in biological tissue.  The governing equation in Cartesian coordinates is 
 

 b b

T T T
k k q wc T T c

x x y y t

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 where  

 T  is the tissue temperature [°C or K, °F or R] 

 Tb  is the blood temperature [°C or K, °F or R] 

 q  is the local metabolic heat generation rate per unit volume [W/m3 or Btu/hr-ft3] 

    is the local tissue density [kg/m3 or lbm/ft3] 

 c  is the local tissue specific heat [kJ/kg-K or Btu/lbm-R] 

 cb is the blood specific heat [J/kg-K or Btu/lbm-R] 

 t  is time [sec or hours] 

 k is the tissue thermal conductivity [W/m-K or Btu/hr-ft-R] 

 w  is the local perfusion [kg/m3-sec or lbm/ft3-hr] 

 

 The tissue properties - thermal conductivity, density, and specific heat - and perfusion rate 
are specified with the Material Properties dialog.  The blood properties - temperature and 
specific heat - are specified with the Blood Properties dialog.  The metabolic heat 
generation rate is specified in the Generation menu item. 
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Potential configures FEHT to solve two-dimensional, steady-state, potential flow problems.  
The governing equation in Cartesian coordinates is 

 


x

x

+

y


y

= 0
 

 where  
 is the stream function [m2/sec]. The fluid velocities, u and v, in the x and y 

directions respectively, are related to  by  
 

u
y

x
v

y

y








 

 
Porous Media Flow configures FEHT to solve two-dimensional steady-state or transient 

problems in flow through porous media, such as occur in underground water flows.  The 
governing equation in Cartesian coordinates is 

 

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

y
k
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y
  - S H
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= 0

 
 where  
 H  is hydraulic head [m] 
 k is the local hydraulic conductivity [m/sec] 
 S  is the specific storage [1/m] 
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Setup Menu 

   
Scale and Size will display the dialog window shown below in which the unit system (for heat 

transfer problems, English or SI), the position on the screen of the origin of the coordinate 
system, the length scale and units, and the grid spacing can be specified.  In addition, 
capability is provided to center the drawing or resize the drawing to fit the video screen. 

   

  
 The unit system controls in the upper left are applicable only for heat transfer problems.  

All other problem types use SI units. 
 

 The origin of the coordinate system is positioned by specifying values in the Origin box at 
the lower left.  In the Cartesian coordinate system, these are designated as X0 and Y0.  In 
cylindrical coordinates, R0 and Z0 are used.  Setting X0 (or R0) to 0 and Y0 (or Z0) to 0 
will place the origin of the coordinate system at the bottom left corner of the screen.  The 
origin values are specified in centimeters (or inches in English) in actual screen 
coordinates.  The Center checkbox selected the coordinate system origin so as to center the 
drawing on the screen, overriding the values supplied for the origin.   

 
 The drawing scale and units are specified in the Scale box at the upper right.  The value 

indicated in the this box is the length which is represented by 1 cm (or 1 inch in English) 
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units on the screen.  Click on the box displaying the units to cycle it through a number of 
units choices.  Each click will rotate the unit to the next possible unit type and 
automatically convert the scale and grid spacing value.  The scale value can be changed by 
clicking the mouse button in the scale rectangle followed by editing.  Note that the drawing 
size itself does not change but rather just the scale.  The ‘Size to fill screen’ checkbox can 
be used to change the drawing size as explained below.  

 
 A grid will be placed on the screen if the Show Grid command in the Display menu is 

selected.  The horizontal and vertical spacing of the lines forming the grid are controlled by 
the values in the Grid Spacing box at the lower right.  The spacing value is entered in the 
unit system and scale of the drawing.  The horizontal and vertical position of the cursor 
corresponding to the selected scale, unit system, and origin are shown in the information 
window at the upper left just below the menu bar. 

  
 The Scale and Size commands should normally be issued before a drawing is started, but it 

can be applied to an existing drawing.  Changing the unit system will result in automatic 
conversion of all defined quantities, but will not affect the display.  Changing the origin of 
an existing drawing will shift its location on the screen.  Changing the scale will not change 
the displayed size on the screen, but it will affect the actual dimensions of the drawing.  

 
 The Size to fill screen checkbox provides a means of changing the displayed size of a 

drawing.  If this option is selected, the existing drawing will be rescaled so that it fills the 
Input Window in the unzoomed mode.  The scale and grid spacing will be adjusted 
accordingly.  This option is most useful when a drawing was initiated on a computer 
having a smaller or larger video display than currently available.   

 
 The ‘Size to fill screen option’ can be used to set the drawing to any desired size.  To 

shrink the drawing, make the Input Window small by first clicking on the size control at the 
upper right of the screen, and then resize the window by dragging an edge.  Next, select the 
Scale and Size command and click the ‘Size to fill screen’ checkbox.  The drawing will be 
resized to fit the smaller window.  Finally, click the size control again to restore the Input 
window to its original full-screen size. 

 
Cartesian instructs FEHT to consider the problem to be two-dimensional in an X-Y coordinate 

system.  The Cartesian option assumes that the object has infinite extent in the direction 
normal to the screen.  Heat flows (or analogous quantities for electric fields) are calculated 
on a per unit (foot or meter) depth.  The position of the origin (i.e., the position on the 
screen where x=0 and y=0) can be changed with the Set Units and Scale command.  The 
axes become visible if the Show Axes command in the Display menu is selected. 

 
Cylindrical  instructs FEHT to consider the problem to be axi-symmetric.  Only the portion of 
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the object to the right of the vertical centerline can be drawn.  The vertical centerline is 
initially placed about one-half inch from the left edge of the screen.  The position of the 
centerline can be changed with the Scale and Size command.  The centerline can be made 
invisible by selecting Hide Axes command in the Display menu.  

 
Steady-State instructs FEHT to consider the problem to be steady-state.  This command, 

which appears only for heat transfer, electric currents  and porous flow problems, will 
disable the Initial Conditions menu item (Specify menu).  The steady-state solution will 
be calculated after the Calculate command (Run menu) is issued.  The Potentials vs Time 
and Flow vs Time windows (View menu) are of course not applicable and will be disabled.  
This command can be entered at any time.  A check mark will appear in front of Steady-
State in the menu to indicate that it has been selected.   

 
Transient instructs FEHT to consider the current problem to be transient (i.e. time dependent).  

This command is available only to heat transfer, electric currents, and porous flow 
problems.  The Initial Conditions command (Specify menu) becomes accessible for 
transient problems.  The start time, stop time, and time step are entered when the Calculate 
command (Run menu) is issued.  The Transient command can be entered at any time.  A 
check mark will appear in front of Transient in the menu to indicate that it has been 
selected.  By default, a problem is assumed to be steady-state.  

 
Temperatures in C and Temperatures in K specify the units in which temperatures will be 

displayed for heat transfer problems.  (In the English system, these commands would apply 
for F and R, respectively.)  The temperature scale in use is indicated by a check mark in 
front of the menu item.  Changing the scale will convert all defined temperatures.  

 
Auto Save saves a backup copy of the file whenever the problem definition is changed.  This 

option has a check preceding the menu name when it is selected.  The Backup command in 
the File menu can be used to open the saved backup file. 
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Draw Menu 

  
Undo reverses the effects of the last change made to the problem definition.  The Undo menu 

name will change to Undo Outline, Undo Lines, Undo Auto Mesh, etc. after using any of 
these drawing commands.  Selecting the Undo command will restore the problem to the 
condition it was in before that last command was issued.  An internal copy of the problem 
information is made in memory when any of the drawing commands are issued in order to 
support the Undo command.  Up to 16 copies are retained in memory. 

 
Outline (free form) is used to define the outline of a material.  Each material is considered to 

have a single set of property values (or equations) and a single internal generation value (or 
equation).  Boundary conditions must be specified for the lines forming the outline of a 
material.  The material outline definition begins by positioning the cursor at a point on the 
boundary of the material and clicking the mouse button.  A node (designated by a small 
circle) will appear at the corner.  (The first node will be displayed as a solid circle, while 
the remaining nodes are displayed as open circles.) From then on, a line between the node 
and the cursor will be indicated.  The cursor is then moved to the next boundary point at 
which a node is desired.  The node is fixed by clicking the mouse button.  This process is 
continued until the mouse is again clicked on the first node (solid circle), creating the 
outline.   

 
 In constructing the outline of a material which borders an existing material, it is necessary 

to trace over the common border, clicking the mouse button on each node in common.  
Material outlines may share a common border, but may not overlap.  To aid in precisely 
locating nodes, the horizontal or vertical position of the cursor can be locked in place by 
holding down the Shift or Ctrl key, respectively.  You can escape from the Outline 
command at any point by pressing the Esc key.  

 
Outline (circular) is used to define the outline of a material that has curved boundaries. FEHT 

represents boundaries as a series of connected straight lines.  This command helps to enter 
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the coordinates of the boundary for circles, semi-circles or quarter-circles.  Selecting this 
command will bring up a dialog that allows specification of the diameter, center location, 
number of points, and circular section type (circle, semi-circle, or quarter circle).  After 
confirmation, FEHT will enter the outline.  Note that the outline may not intersect existing 
outlines.  

  
Auto Mesh creates a relatively crude triangular mesh for the selected outline.  If no outline is 

selected, the mesh will be created for all outlines in the problem description.  It is 
recommended that boundary conditions be set before using Auto Mesh.  Note that the 
outline must not have any existing element lines in order for this command to work.  After 
creating a crude mesh, Auto Mesh calls Reduce Mesh to reduce the size of the triangular 
elements.  Use the Undo command if you wish to reverse this action.  

 
Reduce Mesh can be applied only after all distributed materials are discretized into triangular 

elements  This is usually done with the Auto Mesh command.  Mesh reduction can be 
applied to one or more selected material outline(s) or to all outlines.   

 
 One of two mesh reduction algorithms are used, depending on whether any outlines are 

selected.  When the Reduce Mesh  command is given when no outlines are selected, the 
mesh size of all outlines is reduced by forming new elements constructed with lines 
connecting the center points of existing lines.  Each existing element then results in four 
new elements.  The geometry of the original discretization is preserved.  When the Reduce 
Mesh  command is given while one or more outlines are selected (i.e., flashing), the mesh 
reduction occurs only for the selected outlines by adding a node at the centroid of each 
existing element in the outline and connecting this new node to the vertices of the element.  
Then, if the element lines are not on the border of an unselected outline, they are bisected 
and nodes at each bisection point are connected to the centroid node.  The result is that 
each existing element is reduced into 3 to 6 new elements.  

 
 It is advantageous to set the boundary conditions (or group lines with the Group command 

in this menu before applying Reduce Mesh, since this command may produce many more 
boundary lines.  Alternatively, set the boundary conditions before reducing the mesh. 

 
Reposition Nodes  allows the horizontal and/or vertical position of existing nodes to be 

changed.  After selecting this command, place the cursor on the node which is to be moved 
and move it to its new location while holding down the mouse button.  (The horizontal or 
vertical position of the node can be locked in place by holding down the Shift or Ctrl  key, 
respectively.)  Reposition Nodes remains in effect until the mouse is clicked on something 
other than an existing node.  

 
Element Lines allows manual control over forming a triangular mesh.  This command can be 
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used to create a triangular mesh or improve a mesh that was automatically created with the 
Auto Mesh command.  After selecting the Element Lines command, the cursor must be 
placed on an existing node or line.  Clicking the mouse button fixes one end of the new 
element line, creating a node if needed.  The cursor is then moved to the other end of the 
line which is fixed by clicking the mouse.  This process is repeated as needed.  To aid in 
precisely locating nodes, the horizontal or vertical position of the cursor can be locked in 
place by holding down the Shift or Ctrl key, respectively.  Element lines can not be 
constructed in a lumped material.  Press the Esc key to escape from the Element Lines 
command.  Note that it is not necessary to finely discretize the material as this can be done 
automatically using the Reduce Mesh command. 

 
Delete can be used to delete one or more element lines, nodes, or material outlines.  To delete 

one or more element lines, select the lines to be deleted by clicking the mouse button on 
each line center, causing it to flash.  Then select Delete.  Note that the borders of materials 
are not considered to be element lines and cannot be deleted.   

 
 To delete one or more nodes, click the mouse button on the nodes causing them to flash 

and then issue the Delete command.  A node may be deleted only if it is connected to two 
or fewer lines. It may be necessary to delete element lines before deleting the node.  Nodes 
on the border of a material may be deleted, but care should be exercised so that the 
resulting line does not cross any existing lines.  Clicking the mouse button on any point 
within a material (but not on a node or line) will select that material.  Delete will delete all 
nodes and element lines within the material, as well as the material outline. 

   
New Text allows text to be entered on the selected window.  Note that the text will appear only 

on the window which is foremost with this command is issued.  The following dialog 
window will appear. 

 

  
 Enter the text which is to appear on the window in the edit box.  The text background is 

controlled by the radio buttons.  Transparent displays only the letter, whereas Opaque 
clears a rectangle for the text.  Clicking the Set Font button displays a dialog window in 
which the font, size, and color of the text can be specified.  Click OK or press the Enter key 
when the text specifications are completed.  The text can be repositioned by pressing and 
holding the mouse button down within the text rectangle while sliding the text to its new 
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location.  Double-clicking on a text item will bring up the above dialog window in which 
further changes can be made. 

  
Size/Move Template becomes accessible only after a template has been copied with the Paste 

from Clipboard command (File menu).  The purpose of this command is to reposition 
and/or resize a template drawing so that it may be 'traced' during the problem definition.  
After selecting Size/Move Template, the template drawing will be displayed in front of all 
everything else in the Input Window along with a boundary rectangle and a size box.  To 
reposition the template, press and hold the mouse button down anywhere within the 
rectangle (except within the size box) and drag the template to a new location while 
holding the mouse button down.  The template will be redrawn after the button is released.  
To change the size of the template, press and hold the mouse button down in the size box at 
the lower right corner of the boundary rectangle.  Drag the mouse to the new lower right 
corner.  The template will be scaled and redrawn after the button is released.   

 
 Use the Hide Template command (Display menu) to remove the template from the screen 

when it is no longer needed. 
 
Group becomes available when two or more lines, nodes, or outlines have been selected.  The 

Group command causes the selected items to be grouped into a single entity.  After these 
items are grouped, selecting any one of the items causes all in the group to be selected.  
(Depressing the Ctrl key while selecting the item disables the group selection.)  The 
grouping is in effect only for the window in which it was defined.  Use the Ungroup 
command in this menu to undo the group specification. 

 
 As an example, all boundary lines having identical boundary conditions can be grouped.  In 

this way, the boundary conditions for all of these lines can be easily changed just by 
selecting one of the lines.  Similarly, all nodes on a boundary can be grouped in the Nodal 
Balances window so that the flow across that boundary can be easily determined. 

  
 If an item appears in more than one group, the most recent group will be chosen when that 

item is selected.  Grouped boundary lines are preserved when the Reduce Mesh command 
(Draw menu) is applied.  However, groups are destroyed when the Delete command is 
issued. 

  
Ungroup becomes available when a previously established group of lines, nodes, or outlines 

has been selected.  The group is established with the Group command.  Ungroup destroys 
the group structure relating these items.  
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Display Menu 

   
Zoom (Normal Size) allows a selected part of the screen to be enlarged.  After the Zoom 

command is given, a small rectangle will appear with its upper left corner at the position of 
the cursor.  Move the cursor to the upper left corner of the screen area which is to be 
enlarged and click the mouse button.  Next move the cursor to the lower right corner.  The 
rectangle will grow as needed indicating the viewing area of the enlarged screen.  Click the 
mouse button to complete the Zoom command.  The enlarged screen will be drawn with 
scroll bars at the bottom and right of the screen.  The scroll bars or the arrow keys can be 
used to locate the viewing area anywhere within the drawing.  All drawing and output 
alternatives operate with either the normal size or enlarged screen.  You may find it 
convenient to enlarge the drawing while creating or selecting closely packed nodes or 
element lines.  When the zoom command is effect, the Zoom menu item is changed to 
Normal Size. 

 
Show (Hide) Grid superimposes your drawing on a rectangular grid.  The distance between 

the grid lines can be set with the Scale and Size command (Setup menu).  When the grid is 
made visible, the menu toggles to Hide Grid.  

 
Hide (Show) Element Lines controls the visibility of the element lines which divide a material 

into triangular elements.  You may wish to hide element lines to produce an uncluttered 
display of your drawing or to make it easier to select a material containing many closely 
packed element lines.  Hidden element lines cannot be selected.  The Hide Element Lines 
command toggles the menu item to Show Element Lines.   

 
Hide (Show) Node Positions removes (or restores) the node position markers from the screen. 

The position of nodes is represented either by a small circle (if Hide Node Numbers is in 
effect) or by a larger circle containing the node number.  You may wish to hide node 
positions to produce an uncluttered display of your drawing or to make it easier to select 
materials or element lines.  Nodes can not be selected if they are hidden.  The node position 
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markers are restored with the Show Node Positions command which replaces Hide Node 
Positions in the menu. 

 
Show (Hide) Node Numbers controls the type of marker used to indicate the node positions.  

Each node is identified with a node number.  Lumped materials are identified with a 
number.  It is necessary to know the node numbers for some output operations.  They may 
be displayed with the Show Node Numbers command.  Circles at each node position will 
be drawn around the node number when this command is in effect.  Lumped materials are 
treated in a manner similar to nodes.  A number for the lumped material will be displayed 
at the position within the material at which the mouse was last clicked.  Nodes associated 
only with lumped materials cannot be selected and are shown in inverse.  The node 
numbers can be hidden with the Hide Node Numbers command which replaces Show 
Node Numbers in the menu.  Note that the node number of the last selected node is also 
displayed in the information window at the upper left of the screen whether or not the 
Show Node Numbers command is in effect.  Node numbers may be changed by FEHT 
during delete operations and when a material is changed between lumped and distributed.  
The node numbers showing on the screen are not used in the calculations.  In order to 
minimize the bandwidth, FEHT reorders the nodes  and thereby reduce computational 
effort.   

  
Hide (Show) Patterns removes (or restores) the identifying pattern for each material type from 

the screen.  The patterns are selected with the Material Properties command.  In some 
cases, it may be easier to position nodes and element lines if the pattern is hidden.   

 
Hide (Show) Bound. Conditions changes the screen display so that boundaries and nodes for 

which boundary conditions have been specified are (or are not) represented in bold (i.e., 
double thickness).  Shown in this way, it is easy to see where boundary conditions have and 
have not been specified.  Hide Bound. Conditions causes these lines and nodes to be shown 
normally. 

 
Hide (Show) Text temporarily removes (or restores) the text entered with the Text command.   
 
Show (Hide) Axes controls the visibility of the horizontal and vertical  axes (X=0, Y=0) in 

Cartesian coordinates and the center line (R=0) in cylindrical coordinates.  If the centerline 
or axes do not appear after the command is selected, it may be that the axes are currently at 
the bottom left of the screen or off the screen.  The origin of the coordinates system can be 
changed with the Scale and Size command (Setup menu). 

 
Show (Hide) Template controls the visibility of the template drawing which can be traced 

over to simplify a problem definition.  This command is accessible only after a template 
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has been copied from the Clipboard with the Paste from Clipboard command (File 
menu).  The template is displayed behind existing materials unless the Size/Move 
Template option (Draw menu) is selected. 

 
Refresh Screen simply causes the screen to be redisplayed.  It should not be needed under 

normal circumstances. 
 
Center and Set Display Size is only accessible when the Input Window is active and when the 

input is normal size.  This command will change the scale by an amount determined by the 
slider control.  Setting the slider to the rightmost position will result in the outlines filling 
the screen.  The origin is reset so that the outlines are centered.  
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Specify Menu 

   
Material Properties allows the thermal properties for up to twenty different materials to be 

specified for use in the current problem.  To specify properties, you must first select one or 
more materials by clicking the mouse button on a point within the outline (but not on an 
internal line or node).  The outline of selected materials will flash if the material is 
distributed.  A lumped material will acknowledge selection by flashing the circle with its 
identification number.  The Material Properties command can also be selected by double-
clicking the mouse within the material.  The Material Properties command will display the 
following dialog window. 

 

  
 Select the material type by clicking the mouse button on the property name in the list at the 

left of the screen.  The information corresponding to the material type you select is 
displayed in the boxes to the right of the screen, where they can be changed, if desired.  
Changes made to the property name field will also appear in the property name list.   

 
 Property data must be entered in the indicated units.  FEHT allows properties to be entered 

either as numerical constants or as user-defined functions of potential (e.g., temperature), 
position and/or time.  See the Entering Variable Properties and Boundary Specifications 
section of this chapter for additional information concerning variable properties.  (Constant 
property values, but not equations, are automatically converted in heat transfer problems 
when the unit system is changed with the Scale and Size command (Setup menu).)  All 
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property data are saved with the problem definition when the Save or Save As command 
(File menu) is used.  

  
 Materials may be Distributed, Lumped or Anisotropic.  Anisotropic materials are those in 

which the thermal conductivity differs in the X and Y directions.  Lumped materials have a 
uniform temperature.  Click in the Type box to toggle the choice.  The pattern associated 
with a material can be changed by pressing the mouse button in the pattern box to the right 
of the property Type field.  This will cause a pattern palette to appear showing the possible 
patterns.  To select a pattern, hold the mouse button down while moving to position the 
cursor over the desired pattern in the palette.  The pattern color is selected in the same 
manner by pressing the mouse button in the color palette.  Patterns may be displayed or 
hidden with the Show (Hide) Patterns command (Display menu). 

 
Generation, Volume Charge Density, Bernoulli Constant 
 Generation becomes accessible for heat transfer problems after one or more materials have 

been selected.  (To select a material, click the mouse button on a point within the material, 
but not on an internal line or node.)  Internal generation is entered on a per unit volume 
basis which, for Cartesian coordinates, assumes unit depth of material into the screen.  
Internal generation may be expressed in an equation as a function of temperature, position 
and/or time, as described in the Entering Variable Properties and Boundary Specifications 
section at the beginning of this chapter.    

 
 Volume Charge Density replaces the Generation in the Specify menu for electrostatics 

problems.  The command is accessible after one or more materials have been selected.  The 
volume charge density [Coul/m3] may be entered as a function of voltage, spatial position, 
and/or time.  In Cartesian coordinates, unit depth of material into the screen is assumed.  

 
 Bernoulli Constant replaces the Generation in the Specify menu for potential flow 

problems.  The command is accessible after one or more materials have been selected.  The 
Bernoulli Constant command allows the user to change the zero default value of the 
Bernoulli constant which is used in the calculation of the pressure contours.  The governing 
equation is 

  
P + 1

2  (u2 + v2) = BC
 

 where 
  P  is the local pressure [Pa] 
    is the fluid density [kg/m3] 
  BC is the Bernoulli constant [Pa] 
  u and v  are velocities [m/s] related to the local stream function by 
 

u
y

x
v

y

y
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Boundary Conditions is used to set the values of node potentials (e.g., temperatures, voltages, 

etc.) and material boundary conditions.  This command becomes accessible after one or 
more nodes or border lines have been selected.   

 
 Lines 
 Boundary conditions may be specified for lines which form the outline of a material, but 

not for element lines.  Select all of the lines which are to have the same boundary 
conditions by clicking on the center of each line.  (Use the Zoom and/or Hide Node 
Positions command (Display menu) to make the selection process easier for closely packed 
lines.)  Then select the Boundary Conditions command (or double-clicking the mouse 
button on the last line) to bring up the Boundary Conditions dialog window for lines.  The 
appearance of the Boundary Conditions dialog box will differ depending on the subject 
choice.  The dialog box shown below is applicable for heat transfer problems.   

 

      
 Boundary information may be entered as numerical constants or as equations involving the 

potential and/or time as shown above.  Multiple boundary specifications can be made by 
entering information in the appropriate edit boxes.  To remove a specification, click the 
check box to the left of the name. 

 
 Nodes  
 To enter boundary information for a node, place the cursor on the node and click the mouse 

button causing it to flash and then select the Boundary Conditions command.  
Alternatively, double-click the mouse button with the cursor positioned on the node.  A 
dialog box will appear, as shown below, in which the potential at the node may be entered.  
The potential at the node may be entered as a numerical constant or as an equation 
involving time, and/or spatial position, as explained at the start of this chapter.  To remove 
the specification, click the mouse button in the check box.   
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 If a single node is selected, its coordinates can also be changed with this command.  The X 

and Y (Cartesian) or  R and Z (Cylindrical) coordinates will be displayed in edit boxes 
where the values can be changed.  However, the new coordinates will not be accepted if it 
causes lines to cross. 

 
Point Singularities 

 Point singularities can be specified for nodes in Potential Flow problems.  Selecting the 
Node Information menu item will provide the following dialog menu. 

 

   
 If Specify Point Singularity is chosen, the Point Singularity dialog window appears.  One 

or more singularities of the types indicated in the dialog can be specified (or unspecified) 
for each selected node by clicking in the check box to the left of the singularity type and 
entering the value of the strength.  The entered values must be numerical constants. 
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 Type Singular Solution 
 Source  =  S/(2)  
 Sink  = -S/(2)  
 Vortex  = -S/(2) ln r 
 Doublet (x-axis)  = -S/r sin() 
 Doublet (y-axis)  = -S/r cos() 
 
 where  

  S  is the specified singularity strength [m2/sec] 

   = arctan[(Y-Yo)/(X-Xo)] 

  r = (X-Xo)2 + (Y-Yo)2
 

  Xo and Yo are the coordinates of the singular point   

 
Guess Conditions (Temperatures, Voltages, Head Values) is accessible for heat transfer, 2-

D fins, electric current and porous flow problems only if Steady-State has been specified 
in the Setup menu and one or more nodes or materials have been selected.  This command 
allows the a starting or guess potential (temperature, voltage, or head) to be specified.  This 
guess potential is used only when properties and/or boundary conditions are functions of 
the potential. 

 
Initial Conditions (Temperatures, Voltages, Head Values) is accessible for heat transfer, 2-

D fins, electric current and porous flow problems only if Transient has been specified in 
the Setup menu and one or more nodes or materials have been selected.  This command 
allows the potential (temperature, voltage, or head) to be specified at time 0.  To specify the 
initial potential of one or more nodes or lumped materials, click the mouse on the node 
causing it to flash, execute the Initial Conditions command and enter the potential value.   

 
 The initial potential values of all nodes within a material may be specified by selecting the 

material and then executing the Initial Conditions command.  If the Set node in all 
materials checkbox is selected, then the initial values of all nodes in all materials will be set 
at the specified value. 
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Blood Properties is applicable only for Bio-Heat Transfer problems.  The following dialog 

window will appear in which the temperature and specific heat of blood can be specified.   
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Run Menu 

   
Check will review the problem definition and report any apparent errors.  The problem will 

first be checked to ensure that all distributed materials are divided into triangular elements.  
Lines of non-triangular elements will be marked with a small square.  Use the Auto Mesh 
or Element Lines command (Draw menu) to correct the problem.  The properties of each 
material will be examined next to see that they are all defined.  Materials with undefined 
properties will be made to flash.  The Material Properties command (Specify menu) can 
be used to specify properties.  The boundary conditions will be checked next to ensure that 
all boundary conditions are properly specified.  Boundaries found to be in error will be 
marked with a small square and an explanatory note in the information window at the top 
of the screen.  Corrections are made with the Boundary Conditions command (Specify 
menu).  For heat transfer problems, convective boundaries may not be specified between 
two distributed materials.  For transient problems, nodes with unspecified temperatures will 
be marked with a box centered about the node.  Error messages will be shown in the 
information window at the upper right. 

 
Calculate initiates the calculations.  The problem definition is first checked as described under 

the Check command.  Any error in the problem definition aborts the calculations.  For 
steady-state problems, calculations begin directly after the checking process is completed.  
A dialog box will appear indicating that the calculations are in progress.  The number of 
unknown potentials and the bandwidth of the matrix used in the calculations will be 
displayed.  The calculations can be aborted by clicking the mouse in the Abort button.  
When the calculations are completed, the elapsed time will be displayed and the Abort 
button will become a Continue button.  Click the Continue button to remove the dialog box.   

 
 If no errors are found for transient problems, the dialog window shown below will appear 

in which the stop time, time step and solution method are specified.  The times may be 
entered in either seconds or hours.  Click the mouse in the box with the time unit to toggle 
to the other unit.  The Crank-Nicolson solution method provides greater stability than the 
Euler method and, for finite-elements (unlike finite differences), no computational penalty.  
The Euler method is provided as an option so that the effect of different calculation 
methods on results and stability can be investigated.  A check box is provided for nodal 
balances.  The nodal balances are required if the Nodal Balances or Energy Flows vs 
Time windows are to be used to view the transient output.  If the Do Nodal Balances check 
box is enabled, one or more material outlines for which the balances will be done can be 
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selected from the list  Selecting Nodal Balances is optional because it requires additional 
storage and more computational effort.  A detailed discussion of the use of nodal balances 
is provided in the View menu section and in Chapter 3.  

 

 
 
Continue allows a transient simulation to be restarted using, as the initial conditions, the 

temperatures calculated in a previous steady-state or transient calculation.  This command 
can be used to investigate the effect of time-dependent boundary conditions or varying 
property values.  The Continue command is accessible only for transient  problems and 
only after a steady-state or transient simulation has been previously run.  After issuing this 
command, the transient setup dialog window shown above will appear in which the stop 
time and time step can be entered.  The start time will be set to the stop time of the previous 
calculation (or zero for a preceding steady-state calculation.)  The conditions at this start 
time will be set to those calculated at the end of the previous calculation.   

 
 Another good use for the Continue command is that it enables you to start with very small 

time steps to keep oscillations small and then later increase the time step to make more  
rapid progress (with less oscillations) in the transient solution. 
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View Menu 

  
 
The FEHT program is centered around nine main windows.  Only the Input window is used for 
entering the problem description.  The other eight windows output results in a variety of forms.  
Each command in this menu will bring the corresponding window to the front.  A description 
of the functions and capabilities of for each window are provided in this section. 
 
Input causes the Input Window to be the active window.  The problem description is 

developed in the Input Window which always appears when a problem is started.  
Information particular to the Input window is as follows. 

 
1. The scale of the problem is set with the Scale and Size command.  The coordinates of 

the cursor position are displayed in the upper left information window. 
 
2. Each material is represented by a separate outline composed with a series of straight 

lines developed with the Outline (free form) or Outline (circular) command in the 
Draw menu.  The properties of each material are specified with the Material 
Properties command in the Specify menu.  There is an upper limit of 52 frames, but 
the number of lines and nodes is limited only by available memory.  

 
3. The Paste from Clipboard command in the File menu allows a graphical object 

composed in any other Windows application to be displayed on the screen.  This 
graphical object can be repositioned and resized if the Size/Move Template command 
in the Draw menu is selected.  Then the object can be traced to make the process of 
outlining materials easier.  The use of a template is particularly convenient for circular 
object.  The Hide Template command in the Display menu can be used to remove the 
template display when it it no longer needed. 

 
4. Each distributed material must be discretized into triangular elements using the 

Element Lines and Reduce Mesh commands in the Draw menu.  The number of 
triangular elements is limited only by available memory. 
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5. The location of an existing node can be changed in two ways.  After selecting the 
Reposition Nodes command in the Display menu , the node can be dragged to a new 
location by holding the mouse button down with the cursor positioned on the node 
while moving it to its new location.  Alternatively, the exact coordinates of the node 
can be entered by first selecting the node and then choosing the Bound. Conditions 
command in the Specify menu.  In either case, the node cannot be moved to position 
such that it causes existing lines to cross.    

 
6 Properties or boundary conditions can be specified only after a node, line, or material is 

selected.  A selected object will flash.  To select an object, click the mouse on that 
object.  FEHT first checks to see if the mouse click is on a node, then on a line, and 
then on a frame.  You can hide the nodes and/or lines using the Show/Hide Nodes and 
Show/Hide Lines commands in the Display menu to make the selection process easier.  
Alternatively, you can zoom a section of the drawing to a larger size using the Zoom 
command in the Display menu. 

 
7. Nodes and lines for which boundary conditions have been specified are shown in bold.  

The feature can be disabled with the Hide Bound. Conditions command in the Display 
menu.  

 
8.  Selection of multiple nodes, lines, or groups is simplified by the Group command in 

the Draw menu.  When the objects are grouped, selecting any one of the objects within 
a group causes all of the object in the group to be selected.  For example, you may wish 
to group all boundaries which have the same boundary conditions.  To override the 
group selection, press and hold the Option key while selecting the object. 

 
9.   The name of the current file appears in the window title bar. 
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Potentials displays the calculated potentials applicable to the selected subject.  The menu item 
in the View menu will be renamed depending on the subject , e.g, Temperatures, 
Voltages, Magnetic Potentials, Stream Function Values, Head Values.   

 
 For steady-state problems, this command will immediately display the potential at each 

node in a small circle centered about the node.  The cursor position in the scale used to 
construct the drawing is shown in the information window at the upper left, just below the 
menu bar.  The potential at the cursor position will be displayed in this window when the 
mouse button is depressed.  Note that FEHT only calculates temperatures at the nodal 
positions.  The temperatures at other points are estimated by linear interpolation from the 
temperatures of triangular element enclosing the cursor.  The potentials of closely spaced 
nodes can more easily be seen in an enlarged drawing obtained with the Zoom command in 
the Display menu.   

 
 For transient problems, a dialog window will first appear with a scroll bar to set the time 

for which the potentials are to be displayed.  The potentials at the selected time will appear 
when the dialog window is dismissed.  The time corresponding the displayed potentials is 
shown in the center information window below the menu bar.  Clicking in this window 
causes time to be incremented by one timestep and the potentials at this new time to be 
displayed.   

 
 
Potentials vs Time window is applicable only for transient problems.  The menu item in the 

View menu will be renamed Temperature vs Time, Voltages vs Time, or Head vs Time, 
depending on the subject.  The images shown below are for a heat transfer problem in 
which the potential is temperature. 

 
 The following plot setup dialog window will appear in which 1 to 15 node numbers can be 

entered.  (Recall that node numbers can be displayed with the Show Node Numbers 
command in the Display menu.)  The simplest way to enter the node numbers is to select 
the nodes you wish to plot before selecting the Potentials vs Time command.  The 
appearance of plot symbols, plot lines and a plot legend are controlled by the check boxes 
at the right.   
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 Attributes of the X and Y-axis scales can be viewed or changed by clicking on the 

appropriate tab at the bottom of the dialog window.  The default values for time are the 
start and stop times used in the calculations.  Click on the Temp. Scale tab to set the 
minimum and maximum temperatures for the potential ordinate.  The scale may be set by 
the user or set automatically by clicking the mouse button in the User/Auto box.  The Auto 
option fills in the minimum and maximum potential values for the nodes and time period 
you have selected.  Changes can then be made to these temperature limits.  The Display 
fields control the appearance of the axis numbers.  

  

  
 The plot, shown below, can be moved or resized.  To move a plot, press and hold the 

mouse button down anywhere within the plot rectangle, while moving the cursor to a new 
location.  To resize the plot, press and hold the mouse button down on the lower right 
corner of the plot.  The cursor will be changed into a cross and the plot will resize as the 
mouse is moved.  Double-clicking the mouse anywhere in the Plot Window will cause the 
plot setup dialog window to reappear so any of the plot attributes can be changed. 
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Contours produces a contour plot of the appropriate potential (Temperature, Voltage, 
Magnetic Potential, Stream Function, Pressure, Head) for the selected subject.  The 
following dialog window will appear in which the minimum and maximum potentials must 
be entered.  This may be done by the user or automatically by clicking the mouse button in 
the User/Auto box in preceding the scale.  The Auto option will determine and display the 
minimum and maximum values.   

 

 
  
 Shaded bands or isopotential lines can be selected by clicking the appropriate button at the 

bottom left of the dialog box.  Shaded band contour plots display the variation in the 
potential using five to seven different colors.  Isopotential line plots draw lines of constant 
potential.  The number of lines must be between 2 and 100 and is specified by the user.  In 
both types of contour plots, the value of the potential at the cursor position will be 
displayed in the upper left information window by pressing and holding the mouse button. 
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 Element lines can be made to appear in either white or black by selecting Show element 

lines check box or by selecting Show Element Lines check box menu.  The outline of the 
various materials will be shown if  the Show Outlines check box is selected.   

 
 For transient problems, the contours may be plotted from the start to the stop times as a 

movie or at a selected time by clicking the appropriate button.  The selected time is set with 
the arrow controls to the right of the time.  Each click on the arrow will increment the time 
by one time step.  The time is also shown in the Time box at the top - middle of the screen, 
just below the menu bar.  Clicking the mouse button in the leftmost information window 
below the menu bar will cause the plot to be redrawn for the next time step. 

 
Gradients Window will be titled appropriately for the selected subject.  Examples are 

Temperature Gradients, Current Density, Flux Density, Volumetric Flux.  In all cases, 
this window displays the temperature gradients (for heat transfer problems) or the 
appropriate flux density vector.  The direction of the vector quantity is indicated by an 
arrow and the length of the arrow shaft is proportional to its magnitude.  The magnitude of 
of the vector at the cursor position can be displayed in the upper right information window 
by pressing and holding the mouse button.  The number of arrows and the maximum arrow 
length are specified in the Gradients dialog window, which appears as follows for heat 
transfer problems. 

 

  
 The minimum and maximum magnitudes can be set by the user or automatically by 

clicking in the User/Auto box.  The Auto option will determine and display the minimum 
and maximum magnitudes.  The outline of the various materials will be shown if an X 
appears in the Show Outlines check box.  The X appears or disappears by clicking the 
mouse button within the box.  Similarly, the element lines will be displayed is the Show 
Element Lines check box is selected.  A third check box allows the heat fluxes to be 
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superimposed on the potential contours.  The center of the arrow vectors are placed at equi-
distant locations throughout the distributed materials.  The Arrow Density scroll bar 
controls the distance between the arrow centers.  The length of the flux arrow 
corresponding to the maximum magnitude can be adjusted by the scroll bar.  For transient 
problems, the temperature gradients may be plotted from the start to the stop times as a 
movie or at a selected time by clicking the appropriate button.  The time for which the 
gradients are to be shown is set with the scroll bar.  After the plot has been displayed, the 
gradients for the next time step can be automatically drawn by clicking in the center 
information window, just below the menu bar. 

 
 
Flows Window changes its name depending on the selected subject.  The possible choices are 

Heat Flows, Current, Charge, Magnetic Flux, or Volumetric Flow.  In each case,  the 
direction and magnitude of appropriate flow normal to any selected line will be displayed.  
This command will cause the screen to be redrawn with node positions hidden and all 
element lines shown.  Click the mouse button on the line for which the flow is to be 
determined;  an arrow will appear showing the direction of the flow normal to the line.  The 
magnitude of the flow normal to the line appears in the information window at the top of 
the screen.  The total flow from two or more connected lines may be found by selecting the 
lines in a clockwise or counter-clockwise manner.  You may wish to group the lines to 
make the selection process simpler using the Group command (Draw menu).  The total 
flow for all selected lines is also displayed in the information window.  The sign 
convention is that the flow for the first-selected line is positive.  

 
 Note 
 Because the finite-element method used in FEHT is not optimized for calculating gradients 

at the boundaries of elements, the flow estimate tends to be inaccurate for constant 
potential or unspecified boundaries.  Convective boundaries (for Heat Transfer) provide 
accurate estimates since, in this case, the heat flow calculation is made using the 
convection equation and does not rely on the temperature gradient.  A convective boundary 
can be made to appear as a constant temperature boundary by selecting a large convection 
coefficient and a fluid temperature equal to the known boundary temperature.  An 
alternative solution for constant temperature or unspecified boundaries is to use the 
information in the Nodal Balances window, as described below. 

  
Nodal Balances displays an estimate of the total flow of energy, current, mass, etc. (as 

appropriate to the subject) into a selected nodal system.  The Nodal Balances menu item is 
available only after the calculations are completed.  

 
 The figure on the left shows a material outline discretized into triangular elements.  The 
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figure on the right superimposes the nodal system boundaries.  The calculations in FEHT 
could be viewed as balances on each nodal system, as explained in Chapter 3.  After 
clicking on a node, the total flow of energy, current, mass into that node from outside the 
solid material (or from outside the outline for which nodal balances calculations are done) 
will be displayed in the information window at the upper right.    

 

  
 The total flow into an interior node, such as the center node in the figure above, will always 

be zero.  However, clicking on a node on a boundary, such as the node on the lower right 
will produce the flow into that node across the boundary as represented by the arrows.  The 
total flow across a boundary can be determined by clicking, in succession, on the nodes 
which form the boundary.  In a heat transfer problem, for example, selecting all of the 
nodes bounding a material will display the total energy into the material.  The energy 
across a boundary can also be obtained with the Heat Flows command (or its equivalent for 
other subjects).  However, the Nodal Balances command provides more accurate results 
when the boundary has specified potential or is unspecified.  Energy balances will always 
check when using nodal balances  

 
 When a steady-state problem has more than one outline, the Nodal Balances command will 

first display the following dialog window in which the outlines for the nodal balances are 
chosen.  One or more outlines can be chosen by clicking on the outline name.  Clicking a 
second time deselects that outline.  The nodal system boundaries will be drawn only for 
those outlines which are selected.  The flow of energy, current, mass, etc. between two 
materials can be found by selecting one of the two material outlines.  Nodal balances on the 
boundary nodes between the two materials will give the flow across the boundary nodes 
into the selected material outline.   
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 The nodal balances for each node and outline are stored for steady-state problems.  For 

transient problems, the storage of the balances at each time step could require excessive 
storage.  Consequently, the nodal balances are done for one set of selected outlines if the 
Do Nodal Balances check box in the transient Calculate dialog window is enabled.  

 
Flow vs Time (Energy Flow vs Time Window, Current vs Time, Volumetric Flow vs 

Time) produces a plot of the total flow into one or more selected nodes as a function of 
time.  This command is applicable only for transient problems and only if the Do Nodal 
Balances control in the Transient Solution Setup dialog window is selected (displayed with 
an X in the box).  To use this command, first select the node or nodes for which the energy 
flow is to be plotted.  Then select this command to bring up the following dialog window in 
which the scales for the ordinate and abscissa can be specified.   

 
 The plot controls are identical to those for the Potentials vs Time plot, with the exception of 

the Rate and Integral radio buttons.  If the Integral radio button is selected, the integral of 
the flow quantity will be plotted, rather than the calculated rate value. 

 

 
 
 Clicking the OK button will dismiss the dialog window and display the plot.  The plot can 

be relocated and resized as explained for the Potentials vs Time window.  Double-clicking 
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the mouse button on the Flows vs Time window will bring up the setup dialog window so 
that the appearance of the plot can be changed.  

 
Tabular Output will display a table of calculated results.  The table, similar in appearance to a 

spreadsheet, provides a row for each node. For steady-state problems, each row lists the 
node number,  the node coordinates, the node potential (e.g., temperature) and the nodal 
balance (NB).  For transient problems, the node potentials and nodal balances at each time 
step are displayed in successive columns with a # symbol preceding each step number. 

 
 Specified potential values appear in bold font. 
 
 The format of the data in the columns is initially set to a default setting.  If you wish to 

change the format, click on the header cell of the column you wish to change.  A small 
dialog window will appear in which you can change the display format.  For transient 
problems, the display format you select for the potentials or balances at one time step can 
be applied to all time steps by checking the box below the display format setting. 

 
 Buttons at the top of the window allow you to print or copy the selected section of the 

table.  The buttons are disabled until a selection is made.  To select cells, click the mouse in 
the upper left corner of the desired selection.  Press the Shift key down and then click in the 
lower right cell, scrolling if necessary.  Selected cells will display in inverse video.  Click 
the Select All button at the top of the table to select all cells in the table.  If the data are 
copied to clipboard by clicking the Copy button, they can be pasted into any spreadsheet or 
word processor application.  

 
Input Data Summary produces a summary report of the input information.  The summary 

provides the horizontal (X or R) and vertical (Y or Z) coordinates of each specified node 
having a specified potentias, a list of the boundary conditions, and the property data for 
each material . The information in this window can be copied with the Copy to Clipboard 
command. 
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Help Menu 

  
 

Help Index will activate the Help processor which provides specific information on the use of 
FEHT.  The Help processor will open to the FEHT Information index which lists the 
subjects for which help is available.  Clicking on the subject opens the Help window to 
information for that subject.  Help can also be accessed in two other ways.  Pressing the F1 
key while in FEHT will bring up help information specific to the window or dialog which 
is foremost.  Pressing the Shift-F1 keys will cause the cursor to turn into the Help cursor.  
Select a menu item with the Help cursor to obtain specific explanatory information for that 
menu command. 

 
Using Help shows information provided by the Windows Help processor on how to use the 

features in the Help program. 
 
About FEHT will bring up the FEHT header window.  This window indicates the version of 

your FEHT program and your registration number.  This information will be needed in any 
correspondence with F-Chart Software. 

 
f-Chart Web Site will start your default browser and connect you to the f-Chart web site.  You 

may wish to visit this web site periodically to see if updates have been posted to the FEHT 
program. 
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Examples Menu 

  
 
The Example Problems menu is a user-defined menu that is designed to allow easy access to 
FEHT files.  It can have any name.  It is created with an ASCII file identified with the filename 
extension (.TXB).  When FEHT reads a textbook index file, it creates the menu at the far right 
of the menu bar, as shown above.  The format of the textbook index file is quite simple.  The 
menu shown above was created with the following textbook index file. 
 
Example Problems 
1 
FEHT 
Finite Element Analysis Program 
F-Chart Software 
Reserved 
>Steady-State Heat Transfer 
Cinder block brick|examples\cinder.FET|no.HLP|no.bmp 
Fuel rods|examples\FuelRod.FET|no.Hlp|no.bmp 
Radiation boundary|examples\Holman38.fet|no.hlp|no.bmp 
>Unsteady-State Heat Transfer 
Transient|examples\Transient.FET|no.Hlp|no.bmp 
Freezing water|examples\Freezing.FET|no.Hlp|no.bmp 
Step change in wall|examples\Plaster.fet|no.hlp|no.bmp 
>Potential Flow 
Flow in a venturi|examples\Venturi.fet|no.hlp|no.bmp 
 
The first line in the file is the menu title.  This title is the name of the menu which will appear 
in the menu bar to the right of the Help menu.  The following line is a version number used 
internally by FEHT.  The following three lines provide information about the problem set.  
This information will be displayed whenever any menu item is selected from this  menu.  A 
fourth line containing the word "reserved" is provided for possible future use.  The following 
lines contain a menu item name (preceded by an identifying > character) and then one or more 
problem descriptions.  The menu item name is the name that will appear in the menu list.  
 
Each problem description line contains four pieces of information, separated by a | character.  
The first item is a descriptive name for the problem, which may be up to 128 characters.  The 
second item is the filename for the FEHT program file.  This filename may be partially or fully 
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qualified with directory information.  However, in most cases, directory information is not 
necessary and it should not be included.  The third item is an optional help file which is to be 
associated with this file.  The help file can be an ASCII text file, a Windows HLP file produced 
by a Help formatting program, or an HTML file readable by a browser program.  By 
convention, the help files have a .HLP or .HTM filename extension.  If no help file is available, 
enter NO.HLP for this field.  The final item is the filename for a figure associated with the 
problem.    
 
The .TXB file should be placed in the same location (i.e., floppy disk, subdirectory, or folder) 
with all of the referenced EES program and help files.  When the user selects a command from 
the this menu, a dialog window will appear showing a list of the descriptive names of the 
problems for that menu item.  The user can then select a name from the list and the file 
associated with that problem will be opened. 
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C  H  A  P  T  E  R  3 

The Finite Element Method 
 

 
The finite-element method, like the finite-difference method, is a numerical scheme to 
approximate the solution to a partial differential equation such as that governing the conduction 
of heat in a solid material.  The purpose of this chapter is to present a brief summary of the 
finite-element method used in FEHT to provide a better understanding of the program.  More 
detailed explanations can be found in references 1-3.  
 
The governing partial differential equation for two-dimensional conduction heat transfer can be 
written in Cartesian coordinates as:  (See references 4-8 for the analogous relations in other 
subject areas.) 
 

x
 k

x
T

+
y
 k

y
T

+ q
.

- c
t
T

= 0
(1)

 
where  
 T  is temperature 
 x  is the horizontal position coordinate 
 y is the vertical position coordinate; m 
 k is the material thermal conductivity 
 c  is the material specific heat 

 q  is the internal generation rate per unit volume 
    is the material density 
 t  is time   
 
The objective is to satisfy (1) in a specified area A enclosed by boundary B subject to specified 
boundary conditions (convection, specified heat flux inflow and specified temperature) and an 
initial condition. 
 

Region A

Boundary B
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In the finite-element method, the partial differential equation is transformed into an integral 
expression.  Numerical approximation of the integral then provides an approximate solution.  
The transformation is made by multiplying (1) by an arbitrary function f(x,y) and integrating 
over area A. 

 


A

f(x,y)
x
 k

x
T

+
y
 k

y
T

+ q
.

+  c
t
T

dx dy = 0 (2)[ ]
 

The exact solution, T(x,y,t), would cause the bracketed term to be zero for all x, y, and t.  An 
approximate solution will be sought that will cause the integral to be zero at selected points 
within A, although this solution may not necessarily satisfy the equation at all points within A. 
 
The solution to (2) begins by integrating the first two terms by parts and rearranging to obtain 
 

dt
d


A

fcT dx dy + 
A

x
f

k
x
T

+
y
f

k
y
T

dx dy = 
A

f q
.

dx dy + 
B

f qn
" ds  (3)

  
where qn

"  is the local heat flux into area A along the boundary B. 
 
B, the boundary line over which the last integral in (3) is evaluated can be broken into 
 

 B = Bc +Bs + Ba + Bt                                                               (4) 
where 

   Bc is the convective portion of the boundary for which  qn"  = h (T  - T) 

 Bs is the portion of the boundary with specified heat flux so that  
 qn

" = qs
"

 

 Ba is the adiabatic portion of the boundary for which  qn
"  =  0 

  Bt  is the specified temperature portion of the boundary 
 
Expanding the last integral in (3), the equation can be rewritten to explicitly consider the 
boundary conditions. 
 

dt
d


A

fc T dx dy + 
A

x
f

k
x
T

+
y
f

k
y
T

dx dy =

 

   


A

f q
.

dx dy + 
B

c

f h (T - T) dS + 
B

s

f qs
"ds + 

B
t

f qn
" ds

 

(5)

 
The function f is still to be chosen.  At this point, f will be chosen to have a value of zero along 
a boundary of specified temperature so that the last integral in (5) is identically zero.  No 
approximations have been made thus far.   
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In the finite-element approximation used in FEHT, nodes connected by straight-line segments 
are used to approximate boundary B.  The actual boundary is replaced by a polygon 
approximation.  Additional nodes also connected by straight-line segments, along with the 
boundary nodes, are used to discretize region A into a set of triangular elements.  The 
temperature within each triangular element is assumed to vary linearly between the 
temperatures at the three vertices (nodal points) for that element.  Since the temperature varies 
linearly within an element, isotherms will be parallel, straight lines and the temperature 
gradient will be uniform within each element.  This continuous, piecewise-linear, temperature 
profile is an approximation to the actual temperature profile.  The problem then is to determine 
the temperature at each nodal point.  
 

•

•
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•
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•
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The solution T(x,y,t) will thus be approximated as a vector of n temperatures where n is the 

number of triangle vertices (nodes).  Since the temperature at point x,y within any 
triangular element is assumed to vary linearly between the three vertex temperatures, the 
temperature at any point within a triangular element can be represented by 

 
 T(x,y,t) w1(x,y) T1(t) + w2(x,y) T2(t) + .... + wn(x,y) Tn(t)  =  wT(x,y) t(t)       (6) 
 
where  
 Ti(t)   is the temperature of triangle vertex i at time t 
 wi(x,y) is a ‘weighting’ function for node i that is 1 at node i, 0 at all other nodes, and 

varies linearly from 1 at node i to 0 along the element boundaries opposite to node i as 
shown in the figure below.     
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0
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The matrix (bold) notation appearing in (6) and following equations is to be interpreted as 
 

w
T

= w1 w2 ... wn t =

T
1

T
2

.

.

Tn   
The weighting functions are known functions of x and y found for each element by solving 
three simultaneous algebraic equations of the form 
 

    T
(e)

= C1
(e)

+ C2
(e)

x + C3
(e)

y (7) 
 

for the  C1
(e)

,  C2
(e)

, and  C3
(e)

 in terms of the temperatures at the element vertices.  The weighting 
function for node i for x,y positions within element e composed of nodes i, j, and k is  
 

wi
(e)

(x,y) =
x

ij
y

jk
- x

jk
y

ij

1 x
j
y

k
- x

k
y

j
- x y

jk
+ x

jk
y (8)

  
where xij is shorthand notation for xj – xi.  The weighting functions in the assumed 

temperature distribution, (6), are known.  The n nodal temperatures must still be determined. 
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The next step is to substitute the temperature distribution given by (6) into (5) to obtain 
 

 
dt
d 

A

f c w t dx dy + 
A

x
f

k
x
w T

t +
y
f

k
y
w T

t dx dy =

 

 


A

f q
.

dx dy + 
Bc

f h (T - w Tt ) ds + 
Bs

f q
s
" ds (9)

 
 
For a single f(x,y), (9) will be a single ordinary differential equation involving the n unknown 
temperature functions T1(t), T2(t), ..., Tn(t).  Equation (9) is still not solvable in that there are n 

unknown temperatures but only one equation.  However, f(x,y) can be any function of x and y 
which satisfies the constraint that f(x,y) = 0 along a boundary of specified temperature.  There 
are an infinite number of functions which meet this constraint.  We will choose n such 
independent f functions to be used in (9).  The functions can be represented in matrix notation. 
 

f(x,y)  =  

f1(x,y)

f
2(x,y)

.

.

.

f
n

(x,y)
  

The functions, f(x,y), are arbitrary.  Different choices for these functions will, in general, result 
in different approximate solutions.  The Galerkin [2-3] method is to set fi(x,y) to be identical to 

wi(x,y).  With this definition of f, rearrangement of (9) results in 

 


A

w  c wT
dx dy

dt
dt

+ 
A

x
w

k
x
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+
y
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k
y
wT

dx dy t + 
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whwT ds t

 

 

= 
A

wq
.

dx dy + 
B

c

whT ds + 
B

s

wqs
"

ds (10)

  
The integrals in (10) may be evaluated by summing over all elements.  For example, for the 
area integrals 
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
A

. . . dx dy = 
e

A

(e)

. . . dx dy (11)

 
 
The integration for each individual element is done analytically since the form of w for any 
element is the simple linear function given in (8).  Integration of (10) results in a system of m 
ordinary differential equations where m is equal to n minus the number of specified 
temperature nodes.  These equations are solved by the Cholesky decomposition to obtain the 
temperatures as functions of time.  For steady-state problems, the time derivative term in (10) 
is set to zero to result in a system of m algebraic equations which are solved to obtain the m 
unknown steady-state temperatures. 
 
The system of differential equations resulting from the approximations described above may be 
written using matrix notation as  
 

 
 C t  (K  H) t  g  h  q (12) 

 
where 
 t = temperature vector (contains the temperatures at each nodal point) 

 t  = time derivative of t (contains the time derivatives of each nodal temperature) 
 C  = capacitance matrix (involves density and specific heat of the material) 
 K  = conduction matrix (involves thermal conductivity of the material) 
 H = convection matrix (involves the specified heat-transfer coefficient on the 
        boundary) 
 g = generation vector (involves the specified energy generation per unit volume of the 
        material) 
 h = convection vector (involves the specified heat-transfer coefficient and ambient 
        temperature on the boundary) 
 q = heat-flow vector (involves the specified heat flux on the boundary) 
 
In developing (12) it is assumed that at any instant of time, the density, thermal conductivity 
and specific heat are uniform within each triangular element, although they can differ for each 
element.  The values of the convection coefficients, fluid temperatures and boundary heat flux 
are taken to be uniform along any given boundary segment but can be different for each 
boundary segment.  In determining the numerical values in C, K, H, g, h and q, FEHT 
calculates the contribution from each element and boundary segment and adds them.  An 
element formed by connecting nodes i, j and k will add contributions to rows i, j and k in 
columns i, j and k in C and K and to rows i, j and k in g.  A boundary segment between nodes i 
and j will add contributions to rows i and j in columns i and j in H and to rows i and j in h and 
q.  
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If there were no nodes having specified temperatures, (12) could now be solved for the nodal 
temperatures in t.  If there are nodes whose temperatures are specified (e.g., nodes along a 
boundary whose temperature is specified), modifications to (12) must be made prior to solving 
to ensure that t will contain the correct values of the specified nodal temperatures. When 
running FEHT, the number of unknown nodal temperatures is reported.  
 
For transient problems, FEHT can approximate the solution with either an Euler or a Crank-
Nicolson step-by-step solution. Since the finite-element capacitance matrix C is not diagonal 
(unlike the usual finite-difference formulation), a finite-element Euler solution will not be 
explicit.  Therefore there is no computational penalty for using the more-accurate Crank-
Nicolson method.  Crank-Nicolson is the default setting in FEHT for transient problems. For 
steady problems  T  = 0 and (12) reduces to a system of algebraic equations.  FEHT uses 

Cholesky-square-root decomposition to obtain a direct (i.e., non-iterative) solution of algebraic 
equations (including the solutions of the algebraic equations required for each step of a 
transient problem).  
 
For the purpose of understanding some of the features of FEHT, it is convenient to also think 
in terms of a set of nodal systems in addition to the set of triangular elements. These nodal 
systems are constructed by connecting the centroid of each triangular element to the midpoint 
of each of the three sides of the triangular element.  
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The entries in the vectors in the finite-element equation (12) may be shown to have energy 
significance for these nodal systems. Rearranging of (12) produces  
 

  C t  K t g  h – H t)  q (13) 
 
where  

 C t =  vector containing the rate of energy storage in each nodal system 
 K t = vector containing the total rate of conduction out of each nodal system to 

surrounding nodal systems 
g =  vector containing the energy generation rate within each nodal system 
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 h – H t = vector containing the specified convection into each nodal system 

   q = vector containing the specified heat flow into each nodal system 
 

The finite-element equations represented by (13) may be viewed as being derived from an 
energy balance on each nodal system.  The right-hand side of (13) is the sum of the energy 
generated within each element g plus the sum of the specified convection  h – H t and the 

specified heat flow q into each element.  This energy inflow to each element must either be 
conducted out to surrounding elements K t  or be stored within the element  C t.  

 
To understand how to calculate heat flows across the boundary of the region, it is convenient to 
rearrange (13) by moving g to the other side of the equation to give  
 

  C T K T – g h – H T)  q  (14) 
 
The left-hand side of (14) now involves energy storage, conduction and generation which all 
occur within the region.  The right-hand side of (14) involves the energy inflows at the 

boundary due to specified convection heat flows and specified heat fluxes. A vector  qo , whose 
entries are the energy inflows to each nodal system from outside the region into each of the 
nodal systems, may be defined such that 
 

  qo  C t  K t  g   (15)  
and 
  qo  h– H t  q  (16)  
 
If there are no specified nodal temperatures, either (15) or (16) may be used to calculate the 
heat flow,  qo . For any interior node or for any node on an adiabatic boundary, the 
corresponding entry in  qo  will be 0 because there is no energy flow into these nodal systems 

from outside the region.  For a specified-temperature node there will usually be an unspecified 
energy inflow (or outflow), in addition to specified convection and specified heat flux, that is 
required to maintain the node at its specified temperature.  In this case, (16) cannot be used to 
compute the corresponding entry in  qo  because the unspecified energy inflow is not included 

with the specified convection and heat-flux inflows.  However, (15) can still be used to 
calculate  qo  because the total inflow plus the generation must still be equal to the storage plus 

the conduction out of the element (into surrounding elements in the region).  If you select Heat 
Flows from the View menu and then click on a boundary segment, the heat flow reported is 
based on (16). If you select Nodal Balances from the View menu and then click on a node, the 
boundary heat inflow that is reported is calculated using (15).  Energy balances will always 
check when using nodal balances (15).  
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Guidelines for Choosing a Time Step for Transient Problems 
For conduction transients using either the Euler or the Crank-Nicolson method for stepping 
ahead in time, there is a critical time step. For time steps greater than the critical time step, the 
solution will contain numerically induced oscillations. These oscillations will be unstable in an 
Euler solution but will be stable in a Crank-Nicolson solution. Since the Crank-Nicolson 
oscillations are always stable, the oscillations are most noticeable at the start of a transient and 
diminish as time increases and the correct steady-state solution is obtained. A Crank-Nicolson 
solution with some oscillations is often considered to be satisfactory.  

 
At the start of a transient solution, FEHT makes an estimate of the critical time step and reports 
the ratio of the user’s time step to the estimated critical time step. If the estimate of the time 
step were exact, a ratio greater than 1.0 would mean an Euler solution would be unstable and a 
Crank-Nicolson solution would contain stable oscillations. However, the estimate of the critical 
time step is always less than or equal to the exact critical time step. This means that the ratio 
reported by FEHT will usually be greater than 1.0 when an Euler solution becomes unstable 
and oscillations appear in a Crank-Nicolson solution.  

 
Since a Crank-Nicolson solution is more accurate than an Euler solution (with the same time 
step), is always stable and (unlike finite differences) requires no more computational effort at 
each time step, the Crank-Nicolson solution is preferred for finite elements.  

 
When running a transient problem for the first time, you often have no idea of a reasonable 
time step to use. In this case, specify any time step you want and specify a stop time that is 
about ten times the time step. Run the transient and note the value of the ratio of your time step 
to the estimated critical time step. Select a few nodes and examine a temperature-time plot for 
these nodes. Nodes near boundaries where step changes in boundary conditions are imposed 
will exhibit the most severe oscillations. The plot should give you an idea of the severity of the 
oscillations and an idea of whether the stop time is close to steady state or not. Armed with this 
additional knowledge, run the transient again. Choose a time step such that the ratio of your 
time step to the estimated critical time step is about 5 or 10. Adjust the stop time if the previous 
stop time seemed to be too short or too long but you may still want to take only a few steps in 
the solution. Run the solution again and examine the new temperature-time plot. Readjust the 
time step and stop time and run again as needed to obtain an acceptable solution.  

 
There are two factors that will reduce the estimated critical time step (and therefore the time 
step for an acceptable solution). Smaller elements will reduce the critical time step. One mesh 
reduction will decrease the critical time step by about a factor of four (problem dependent). 
Increasing the heat-transfer coefficient will eventually reduce the critical time step. Therefore, 
modeling a step change in boundary temperature by a step in fluid temperature with a large 
heat-transfer coefficient is not recommended.  
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The initial condition affects the severity of the oscillations. One way to approach a problem 
that has severe oscillations when using a “large” time step is to reduce the time step for a few 
steps and then continue the transient with the “large” time step. For example, start the transient 
with a time step that is one-tenth of the “large” time step and take ten steps. Then continue the 
solution using the “large” time step. The initial condition of the continued solution will 
produce less severe oscillations in the continued solution than if the “large” time step had been 
used for the entire transient.  

 
Factors that have no bearing on the critical time step are: fluid temperature, generation and 
specified heat flux.  
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A P P E N D I X  A 

Hints for using FEHT 
 
Listed below are a number of suggestions which simplify the use of FEHT.  Some of these 
suggestions are described in the manual, but they are easily missed. 
 
1. It is best to set the boundary conditions before beginning the discretization process.  

Discretizing necessarily breaks the boundary lines into smaller pieces so that more 
selections are needed to set the boundary conditions after discretization.   

 
2. The Group command (Draw menu) simplifies the selection process for lines and nodes.  It 

is a helpful to group all boundary lines or nodes which have the boundary or initial 
conditions.  Once they are grouped, all of the selected items in the group will be selected if 
you click on any one.  The Group command is in effect only for the window in which it 
was created.  Press the Ctrl key to overide the group selection. 

 
2. The Zoom mode enlarges a chosen section of the screen and thereby facilitates the 

placement or selection of nodes or element lines in tight places.  When constructing an new 
outline or element lines, you may wish to scroll a hidden part of the screen into view.  You 
can’t click on the scroll bars because that would interrupt the drawing process.  However, 
you can use the arrow keys to scroll.   

 
3. To set the cursor at a specific X,Y position during drawing operations, it is easiest to first 

move to the correct X value.  Then hold down the Shift key to lock the X position of the 
cursor while you move to the correct Y value.  The Ctrl key locks the Y cursor position.  If 
you wish to exactly specify the coordinates of a node, double-click the mouse on the node 
in the Input Window.  A dialog window will appear in which the coordinates of the nodes 
can be entered 

 
4. Some of the patterns used to identify materials visually interfere with the construction of 

element lines or obscure the template which is being traced.  Use the Hide Patterns 
command to temporarily hide the patterns. 

 
5. Use the Save command often as you prepare the problem definition.  You should always 

save your work before using the Reduce Mesh or Delete commands (Draw menu). 
 
6. To prepare the problem definition of systems with complicated shapes, it may be 
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advantageous to construct the drawing with a drawing programs or scan it in.  The drawing 
can then be copied to the clipboard with the application's Copy command.  After this is 
done, the drawing can be imported into FEHT with the Paste From Clipboard command 
(File menu) and moved or resized as needed.  Trace over the drawing while using the 
Outline command (Draw menu) and then use Hide Template to remove the template from 
view.   

 
7. The Heat Flows command provides an estimate of the heat flow across any line you select.  

Because the finite-element method used in FEHT is not optimized for calculating 
temperature gradients at element boundaries, the estimate tends to be inaccurate for 
constant temperature or unspecified boundaries.  Specified heat flux boundaries are, of 
course, not a problem since the heat flow is known.  Convective boundaries also provide 
accurate estimates since, in this case, the heat flow calculation is made using the 
convection equation and does not rely on the temperature gradient.  A convective boundary 
can be made to appear as a constant temperature boundary by selecting a large convection 
coefficient and a fluid temperature equal to the known boundary temperature.  
Alternatively, the Nodal Balances window provides accurate estimates of the energy flows 
across any material boundary. 

 
8. The Center Drawing and Size to file screen options of the Scale and Size command are 

handy when switching between machines with differing screen sizes.   
 
9. The Continue command can be used to allow variable time step sizes in a transient 

calculation.  Improved accuracy will result when smaller time steps are used during periods 
of rapid temperature change.  

 
10. See the section entitled Guidelines for Choosing a Time Step in Chapter 3 for optimizing 

your specification of the time step used in transient problems. 
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A P P E N D I X  B 

Program Information 
 
 
 
FEHT limitations regarding problem size are as follows:  An error message will be issued if 
any of these limitations are exceeded. 
 
   Maximum number of nodes        12000 (commercial version) 
  Maximum number of line segments available memory 
  Maximum number of material outlines 52 
 Maximum number of triangular elements available memory 
 
 
FEHT will internally renumber nodes so as to minimize the bandwidth of the problem using 
the algorithm of Collins. 
 
Collins, R.J. “Bandwidth Reduction  by Automatic Renumbering,” International Journal for 
Numerical Methods in Engineering, Vol. 6, pp. 345-356, (1973). 
 
The calculation section of FEHT has been adapted from FEM2D, a FORTRAN program 
developed by Glen Myers,  Dept. of Mechanical Engineering, University of Wisconsin - 
Madison.  
 
  
FEHT was developed with Borland’s Delphi. 
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